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Preface

Thank you for using DocuWorks ™.

DocuWorks document handling software provides you with a uniform way to handle data in
a wide variety of office situations.

With DocuWorks, you can handle both documents created by PC (personal computer)
applications and data acquired by scanning as DocuWorks format data. This data can also
be sent as e-mail or printed on a printer.

This manual describes how to install the software from the DocuWorks 8 installation media.
Be sure to read this manual before using DocuWorks.

For the details of the functions of DocuWorks, refer to Help.

The description of this manual assumes that the user is familiar with the basic operations of
Microsoft® Windows®.

Fuji Xerox provides a wide variety of information related to DocuWorks on its web pages.
We hope you will find it useful.

http://www.fxap.com.sg/docuworks

Fuji Xerox Co., Ltd.



About DocuWorks Manuals

The manuals of DocuWorks are contained in the installation media.

Type of Manuals

DocuWorks Manuals

The following manuals provide information on the functions and operations of DocuWorks.

Manual Name

Description

Manual File Format

Setup Guide
(this manual)

® Contents

It explains operating environments and
installation procedure of DocuWorks.

PDF file

Help

® Contents

Help explains the overall features of DocuWorks

and details of each function. You can use Help

as a reference to understand the general

description, as well as each operation and

functionality of DocuWorks. You can also refer to

Help to find out about setting procedures in

dialog boxes while using DocuWorks.

It mainly describes the following main points.

® Overview and new functions

® Setting up and usage of operating
environment with windows

® All operations

® Menus and functions of dialog boxes

® Specifications, compatibilities, cautions and
constraints

® How to display

You can view it by selecting [Help] > [DocuWorks
Help] on DocuWorks Desk or DocuWorks Viewer
window.

CHM file

Release Note

® Contents

It describes information you should read before
working with DocuWorks.

Cautions and Constraints concerning
DocuWorks are explained.

® How to display

You can view it by selecting [Start] > [All
Programs] > [Fuji Xerox] > [DocuWorks] >
[Readme] > [Readme(DocuWorks)].

HTML file




Using This Manual

This manual includes the following contents.

B 1 Before You Install DocuWorks

Before installing DocuWorks, this section describes requirements for operating
environments and installation settings.

B 2 Installing Software

This section describes procedures to install application software contained in the
installation media.

B 3 Executing the Configuring of Personal Settings

This section describes how to configure the required personal settings when using
DocuWorks for the first time.

B 4 Activating a License

This section describes how to activate the license for DocuWorks, how to upgrade from
the trial to the licensed edition, and how to deactivate the license.

B 5 Uninstalling Software

This section describes procedures to uninstall application software.



Conventions

The following symbols are used in the manual.

Symbol Meaning
Important Indicates important information that you should read.
Note Indicates additional information on operations or features.
Reference Indicates the titles, manuals or Help for references.

Indicates names of other manuals, and titles of sections within this manual for
references.
Also indicates folder names, file names, and directory path names.

[ 1] Indicates dialog box names, and item names and button names in the dialog
boxes, e.g. Click the [OK] button.
Also indicates Help titles.

> Indicates hierarchy of the menus, e.g. Select the [Start] menu of Windows, and
[All Programs] > [Fuji Xerox] > [DocuWorks].

® This manual describes the DocuWorks screens and operations taking Windows 7 as an
example. For those who use operating systems other than Windows 7, please read
information according to the respective environment.

® This manual refers to Microsoft® Windows® Operating System as "Windows".

® The term, "select" used in this manual refers to an operation to choose the menu items or
items in the dialog box. The term, "click" refers to an operation to place a cursor over a
button in the dialog box and press the left button of the mouse.

® The following terms may be abbreviated in some cases:
* "DocuWorks Desk" may be abbreviated as "Desk".
* "DocuWorks Viewer" may be abbreviated as "Viewer".
* "[DocuWorks Desk] window" may be abbreviated as "Desk window".
» "[DocuWorks Viewer] window" may be abbreviated as "Viewer window".

® A "DocuWorks document”, a "DocuWorks binder", and a "DocuWorks container" together
may be called "DocuWorks file" collectively.

® "Microsoft® .NET Framework 3.5 SP1" is referred to as ".NET Framework 3.5".
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1 Before You Install DocuWorks

Before you install DocuWorks, check the necessary environment and settings for
installation.

1.1 What to Check Before Installation

Check the operating environment before installation.

Operating Environment

To use DocuWorks 8, the hardware must meet the following requirements:

Operating Environment for DocuWorks 8

Operation System (Note 1) Wlndows 8.1 (32-bit) English Version [without Service Pack]
(OS) Wlndows 10 (32-bit) English Version [without Service Pack]
Wlndows 8.1 (64-bit) English Version [without Service Pack]
Windows® 10 (64-bit) English Version [without Service Pack]

cpy (Note 2) 1 GHz or above 32-bit (x86) or 64-bit (x64) processor

Hard disk (Note 2) 950 MB or more for installation (Not€ 3)
Additional 200 MB or more free space is recommended for actual
operation.

Memory (Note 2) 512 MB or more (1GB or more recommended)

Display (Note 2) 1280 x 768 pixels or more, full colors
Other required hardware DVD-ROM drive is required when installing from the installation media
Other required software Mlcrosoﬂ® Internet Explorer 8, 9,10, or 11
Windows® Search 4.0 is required when using the fast search function
with indexing
Compatible scanners TWAIN32 compliant
Other requirements You will need an internet connection for license activation. Also, user

t(Note 4)

registration to Fuji Xerox Direc will be required.

(Note 1) For the latest information on the supported operating systems, please visit
Fuji Xerox official website.

(Note 2) According to the recommended values for OS you use.
(Note 3) If .NET Framework 3.5 Service Pack 1 has not been installed on the
computer, additional 500 MB or more free space is required.

(Note 4) The following information is required at user registration:
E-mail address, name, address and phone number.
Corporate users are required to enter their organization name and
department name, in addition to above.
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Operating Environment for DocuWorks Creator for Microsoft Office

Supported Microsoft Office | Microsoft Office 2010
version Microsoft Office 2013
Microsoft Office 2016
Microsoft Office 2019

User Privileges

The user who will install DocuWorks must have Administrator privileges. Check whether the
user who will install the DocuWorks belongs to the Administrator group.

1.2 Installation Overview

To use DocuWorks 8, you must install DocuWorks 8 on your computer and then configure
"Personal Settings".

Once the installation is complete, the necessary files are copied to your computer. By using
Personal Settings, you can configure the DocuWorks environment for each user.

New Installation or Upgrading an Earlier Version of DocuWorks

DocuWorks 8 has installation methods as described below.

H New Installation

Used to newly install a DocuWorks 8 first-time install package on computers.

The first-time install package can also be installed on computers on which an earlier
version of DocuWorks is already installed. In this case, on computers on which
DocuWorks 6.x or earlier version is installed, DocuWorks 8 is installed by overwriting the
existing version. On computers on which DocuWorks 7.x is installed, DocuWorks 7.x is
uninstalled before installing DocuWorks 8.

B Upgrading an Earlier Version of DocuWorks

Used to install a DocuWorks 8 upgrade package on computers on which DocuWorks 6.x
or DocuWorks 7.x is installed. On computers on which DocuWorks 6.x is installed,
DocuWorks 8 is installed by overwriting the existing version. On computers on which
DocuWorks 7.x is installed, DocuWorks 7.x is uninstalled before installing DocuWorks 8.

The DocuWorks 8 upgrade package can also be installed on computers on which
DocuWorks 6.x/7.x is not installed, if you have a serial number for DocuWorks 6.x/7.x.
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The Installation Screen

Close all the active applications and insert the DocuWorks 8 installation media into your
media drive.

The autorun screen appears automatically.
Note If autorun screen does not appear, execute the "autorun.exe" file under the "autorun”
folder in the installation media.
Select a language for your installation, and the following screen appears.
| DocuWorks 8 o = (==
DocuWorks 8

| Setup Guide |

| Installation of DocuWorks 8
N ) Inztall Docuwiorks 8.

Installation of bundled application
|’ | Docuworks Tray 2
N ) Ingtall Docuwiorks Tray 2.

Docuworks OCR Multi Language Package
|\ J Ingtall Docuvforks OCR Multi Language Package.

i | Docuw orks Extended Folder For Working Folder 1.5
|\ | Install D ocutorks Extended Folder for Working Folder 1.5.

Docuworks Extended Folder for SharePoint Services 1.0

|\ | Inztall Docutsorks Extendad Folder for SharePaint Services 1.0

Installation of application for browsing
|’ | Docuworks Yiewer Light 8

J Inztall a free tool that can dizplay / print Docuworks file.

FUJI XEroX @) | RekaseNote | [ DvDROM | | ui
) . J

B Setup Guide

If you click this button, "DocuWorks 8 Setup Guide" (this manual) appears.

B Installation of DocuWorks 8

If you click this button, Visual C++ 2015 Runtime is first installed, and then DocuWorks
8 is installed.

After the installation of DocuWorks 8 is complete, the installation of .NET Framework
3.5, .NET Framework 4.6, License Management component, and DocuWorks PDF
Creator, starts one by one.

Reference "2.1 Installing DocuWorks 8" (P.15)

B DocuWorks Tray 2
If you click this button, DocuWorks Tray 2 will be installed.

B DocuWorks OCR Multi Language Package
If you click this button, DocuWorks OCR Multi Language Package will be installed.



1 Before You Install DocuWorks 1 0
B DocuWorks Extended Folder for Working Folder 1.5

If you click this button, DocuWorks Extended Folder for Working Folder 1.5 will be
installed.

B DocuWorks Extended Folder for SharePoint Services 1.0

If you click this button, DocuWorks Extended Folder for SharePoint Services 1.0 will be
installed.

B DocuWorks Viewer Light 8
If you click this button, DocuWorks Viewer Light 8 will be installed.

Reference "2.2 Installing DocuWorks Viewer Light 8" (P.22)

B Release Note

If you click this button, Release Note for the entire installation media is displayed. By
clicking the links inside, you can display individual Release Notes. Release Notes
describe the cautions and constraints. Be sure to read them before using the software.

H DVD-ROM

If you click this button, the files in the installation media are displayed.

B Quit

If you click this button, the installation screen closes.

User Registration with Fuji Xerox Direct

You need a user ID (e-mail address) and password that are registered with Fuji Xerox Direct
in order to use DocuWorks as the licensed edition.

Visit the following URL via your web browser to perform user registration:
https://direct.fujixerox.com/ap2/register/ols/

[E=8 Eem S|

‘ https:/fdirect fujixerox.com/apfregister/olsfenf o~ C‘ I3 5 fel
- Fuji Xerox Direct User Regis... % | |

File Edit View Favorites Tools Help

FUJI Xerox ‘:§ Fuiji Xerox Direct

Fuji Xerox Direct User Registration (Fuji Xerox Online Service User Registration)

Select the country in which you have purchased our product as the registration procedures are different.

| Japan ‘ ‘ Overseas

< >
httpsi/fdirect fujixerox com/ap2/register/ols/en/# S 10% -
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Flow of Installing DocuWorks 8

The installation flow of DocuWorks 8 is as follows:

User Registration with Fuji Xerox Direct
Required when installing as licensed edition.

Exit the running applications

¥

Insert the installation media in the drive

¥

Select language for the installer

R 2

Select installing DocuWorks 8

¥

A MY Y
— U U

[ Select the setup type )
[Standard] [Custom]
All the items are set as the default. Select all the items sequentially.
( Select the installation destination

: &

[ Select whether or not to use DocuWorks Viewer )

Control
— J

[Select whether or not to create the shortcut to Desk )

; J

( Installation of DocuWorks is complete J
( Select trial or licensed edition j
Trial Edition 2 ( Licensed Edition )
The products are installed as trial edition. =

Activate the license
Enter the serial number, and a user ID and password
for Fuji Xerox Direct.

1 |

Install other related software"!

Install DocuWorks PDF Creator.
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*1 Even if the installation of DocuWorks fails or is canceled, the installation of other
software starts.

*2You can upgrade from the Trial to the Licensed Edition later. In this case, refer to "4.4
Upgrading from the Trial to the Licensed Edition" (P.57) to activate the license.

Flow of Personal Settings

When you use DocuWorks for the first time, you must configure Personal Settings.
The flow of Personal Settings is as follows:

[ Select install method )
[Standard settings] [Customize settings]
All the items are set as the default. Select all the items sequentially.

¥

Select a Desk folder

¥

Select the folder for temporary files J

. 2

[Select the application in which DocuWorks Creator for

Microsoft Office is enabled

¥

Select the shortcut to be created )

Customizing Installation

Administrators may want to customize installation, for example, when installing DocuWorks
on multiple computers.

Customizing Which Applications Are Installed

After you start the DocuWorks installer, software applications are installed in the following
sequence:

® Microsoft Visual C++ 2015 Redistributable Package
® Fuji Xerox DocuWorks 8

® Microsoft .NET Framework 3.5 Service Pack 1

® Microsoft .NET Framework 4.6

® Sentinel RMS License Manager for FX

® Fuji Xerox DocuWorks PDF Creator
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To prevent unwanted products from being installed, follow the steps below to customize
installation.

A W N =

Insert the DocuWorks 8 installation media into the disk drive, and open it in Explorer.
Copy the "dw_ml" folder to a hard drive on your computer.
Open the "dw_ml" folder copied on your hard drive.

Use an application which is capable to save character code of a file as Unicode to open
"setup.ini" in the "dw_ml" folder.

The DocuWorks installer (setup.exe) runs installers of applications specified in sections
[Setup01] to [Setup10] in the "setup.ini" file, sequentially in that order. By deleting

sections for unwanted products, you can prevent the corresponding installers from being
started.

Delete sections for products you do not want to install.

Do not delete sections other than [Setup06] (Fuji Xerox DocuWorks PDF Creator).
When using the "Conversion to PDF (DocuWorks PDF Creator)" plug-in of DocuWorks,

the section [Setup06] (Fuji Xerox DocuWorks PDF Creator) is required.
Save the "setup.ini" file.

Then you can run installation according to the customized "setup.ini" file, by double-
clicking the "setup.exe" file in the "dw_ml" folder copied on your hard drive.

Disabling the "Neighborhood Desks" Feature

If you do not want to install the "Neighborhood Desks" feature, follow the steps below to
customize installation.

1
2

Insert the DocuWorks 8 installation media into the disk drive, and open it in Explorer.
Copy the "dw_ml" folder to a hard drive on your computer.

Open the "dw_ml" folder copied on your hard drive, and then open either of the
following folders in it:

» For 32-bit operating systems: "DocuWorks" folder

* For 64-bit operating systems: "DocuWorks64" folder

Create a text file named "dw.ini" in the "DocuWorks" or "DocuWorks64" folder.

Add the following lines in the "dw.ini" file.

[OptionFile]
NeighborhoodDesks=N
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6 save the "dw.ini" file.

Then you can run installation according to the "dw.ini" file, by double-clicking the
"setup.exe" file in the "dw_ml" folder copied on your hard drive.

Besides [OptionFile], you can use the "dw.ini" to customize the settings. For details, after
installing DocuWorks, refer to Help [Customize DocuWorks] > [Customize Installation].

Silent Installation

Although the DocuWorks installer gives you an option to proceed installation without dialog
boxes, the "Silent Installation" function, whenever you attempt to install DocuWorks
requiring license activation, a dialog box where you must enter the serial number and
activate your license appears. Therefore, it is not advisable to use silent installation for
DocuWorks requiring license activation.



2 Installing Software 1 5

2

Installing Software

2.1

This section describes how to install each application software from the DocuWorks 8
installation media.

After the installation, configure Personal Settings by referring to 3.1 "Executing the
Configuring of Personal Settings" (P.26).

Important Another method for installing DocuWorks 8 is to copy the installer to your hard drive.
However, please note that installation may fail with an error message if the full path
for the folder which stores the installer contains characters of a language other than
the default language of the operating system running on the computer.

Installing DocuWorks 8

This section explains how to newly install DocuWorks 8 or upgrade an earlier version.

Important The following information is required in order to install DocuWorks 8 as licensed
edition.

* The serial number, which is printed on the license certificate enclosed in the
product package.

* Your user ID (e-mail address) and password that are registered with Fuji Xerox
Direct.
If you have not yet completed registration, refer to "User Registration with Fuji
Xerox Direct" (P.10) to complete registration.

1  Close all the active applications and insert the DocuWorks 8 installation media into the

media drive.

The autorun screen appears automatically.

Note If autorun screen does not appear, execute the "autorun.exe" file under the "autorun"
folder in the installation media.

2 Click the language for the installation.
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3 Click the button on the left of [Installation of DocuWorks 8].

Note If the [User Account Control] dialog box appears, click [Yes].

2| Docuorks 8 = &

DocuWorks 8 Ewr—

I 'nstallation of DocuWorks 8
nztall Docuiworks 8.
Installation of bundled application

DocuWorks Tray 2
Install Docuwiorks Tray 2.

Docuworks OCR Multi Language Package

Inztall Docuiworks OCH Multi Language Package.

Docuworks Extended Folder for Working Folder 1.5
Ingtall Docuiw/orks Extended Folder for Working Folder 1.5.

[ l Docuworks Extended Folder for SharePoint Services 1.0
Install Docuiwiorks Extended Folder for SharePoint Services 1.0,

Installation of application for browsing
DocuWorks Yiewer Light 8

Install a free taal that can display / print Docutworks file.

EUJI Xerox ;) [ ReleaseMote | [ DVD-ROM ] [ Quit ]

Microsoft Visual C++ 2015 Redistributable is installed.

4 i your computer has DocuWorks 7.x installed, a confirmation dialog box is displayed to
check whether to uninstall DocuWorks 7.x.
When you click [Yes], DocuWorks 7.x is uninstalled, and then the dialog box for step 5
is displayed.
When you click [No], the installation is cancelled.

5 cClick [Next].

rﬁ DocuWorks 8 Setup M1

Welcome to DocuWorks 8 Setup Wizard

DocuWWorks 8 will be installed. Click Next to continue.

< Back I MNext = I Cancel

The [License Agreement] dialog box appears.
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6 Verify the information displayed in the DocuWorks licensing agreement. If you agree to

the licensing conditions, select [| accept the terms in the license agreement], and then
click [Next].

7  Selectthe setup type, and click [Next].

The default is [Standard].
* [Standard]
Install items as the default settings. Proceed to Step 11.

* [Custom]
Install items changing the default settings. Proceed to Step 8.
[ '_'E! DocuWorks 8 Setup [ér
Setup Type e
Choose the setup type that best suits your needs, FUJI Xerox ._")
Flease select a setup type.
~
Installation will be executed with standard settings.
) Custom
‘You can select an installation destination and option settings. This
option is recommended for users who are familiar with the product.
\ J
InstallShield
[ < Back ” Next = ] Cancel

8  Select the installation destination folder, and click [Next].

[ ‘_’@ DocuWorks 8 Setup [él1

Destination Folder

-
Click Mext to install to this folder, or dick Change to install to a different FUJI X€MOX ._)'
folder.

G Install DocuWorks 8 to:
C:'Program Files\Fuji ¥erox\DocuwWorks\,

Installshield

Important Do not install DocuWorks to the following locations. Otherwise, the software may
malfunction.

* Network folder
* Directly under the drive such as "C:\"
* Removal media such as CD-R/RW, MO, or memory card

Note In new installation, the default is "C:\Program Files\Fuji Xerox\DocuWorks".
When upgrading an earlier version, the default is the folder where an earlier version of
DocuWorks has been installed.
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Select whether or not to use DocuWorks Viewer Control, and click [Next].

18

If you select [Use], you can edit the DocuWorks files displayed on a web browser such as by pasting

annotations or changing attributes, and save it.

[ ‘_’E DocuWorks 8 Setup @1

Use of DocuWorks Viewer Control

-
‘fou can select whether DocuWorks Viewer Control will be used to FUJI Xerox ._‘J,‘
display and edit DocuWorks documents on Internet Explarer.

Do you want to use DocuWorks Viewer Control to display DocuWWorks documents on
Internet Explorer?

() Do not use

Select "Use™ to enable the feature of displaying or editing DocuwWorks documents on
Internet Explorer.

Installshield

[ < Back ” MNext = ] Cancel

10 Sselect whether or not to create the shortcut to Desk on the desktop, and click [Next].

11

[ ‘_'@ DocuWorks 8 Setup @1

Shortcut to DocuWorks Desk

e
You can select whether to create the shortcut to Docuorks Desk on  FUJI XEMOX ._J)
the desktop.

Do you want to create the shortcut to DocuWorks Desk on the desktop?

(7) Do not create

Select "Create” to create the shortcut to DoculWaorks Desk on the desktop. Select Do not
create” to not create the shortout.

InstallShield

[ < Back ][ MNext = ] Cancel

Confirm the settings, and click [Install].

[ '_'E! DocuWorks 8 Setup @1

Ready to Install the Program -
FUJI Xerox '._,)

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

DocuwWorks 8 installation destination:
C:\Program Files \Fuji Xerox\DocuWorks',

Select DocuWorks Viewer Control: Use
Create Shorteut to DocuWorks Desk: Create

Installshield

[ < Back H Install ] Cancel
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12 Click [Finish].

19

-
ﬂ DocuWorks 8 Setup

dose Wizard.

Setup Wizard has completed.

DocuWorks 8 has been installed successfully. Click Finish to

Cancel

Sentinel RMS License Manager for FX is installed.

13 Select either of the following options, and click [Next].

* [Install trial version.]

DocuWorks will be installed as trial edition. Proceed to Step 15.
* [Enter the serial number to install the licensed version.]
The serial number is the number printed on the license certificate that is enclosed in

the product package.

The serial number is checked for validity. Proceed to Step 14.

[ DocuWorks I.ér
Enter the zerial number and click [Mext].
™ Ingtall trial version.
LG Erter the serial number to install the licensed version.
Serial Number
I |
Important If you click [Cancel], a dialog box is displayed to confirm whether you want to cancel

the license activation. Clicking [No] returns you to the dialog box for step 13.
Clicking [Yes] moves you to step 15 and installs DocuWorks as trial edition.

DocuWorks

-
|

| . B
Y the license is activated.

within this period.)

@ % The license has not been activated. You can use the trial version until

(Use of the trial version is limited to 60 days. Please activate the license

Are you sure you want to cancel license activation?
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Note If you are running an upgrade install, the installer checks the serial number and then
displays a dialog box to enter the serial number for DocuWorks 6.x/7.x. Enter the serial
number for DocuWorks 6.x/7.x and click [Next].

r =
License Management Lﬁj

IF you have a serial number of one Docuiwiorks B.0, 7.0, 7.1, 7.2 and 7.3 of, available as a
commercial product version when | have you enter the serial number of them,

Serial Number

— - - —
Hext | Cancel |

%

14 Enter your user ID (e-mail address) and password, and click [OK].

* In [User ID (E-mail address)], enter your user ID (e-mail address) registered with Fuiji
Xerox Direct. You must enter the whole e-mail address including the part to the right
of the at sign (@).

* In [Password], enter the password registered with Fuji Xerox Direct.

* Clicking [New Registration] starts your web browser and connects to the user
registration page on Fuji Xerox Direct. It is advisable to complete user registration in
advance by following the instruction in "User Registration with Fuji Xerox Direct"
(P.10). If you prefer not to receive e-mails about the product information, deselect the
check box.

License Management @

Enter the Uzer ID (E-mail address] and Password if pou have alieady registered for the Fuji <erox
Direct.

*‘when authenticating far the very first time or even when e-mail delivery is not required, it will be
dizplayed with a check mark. [f you do not wizh to receive e-mail, uncheck the selection.

Uszer 1D Fui T I
(E-mail sdress] wi_T aro@example. com

Pazzword teseseee

| E-mail delivery iz required for information related to this product

If you have not registered, click [Mew Feqistration] to register at the web site.

Mew Reqistration [ QK ])| Cancel |
Important If you enter your former user ID (a 10 digit number) you registered for DocuWorks 7

or earlier, the dialog box shown below is displayed. Click [OK], and enter your user
ID (e-mail address) registered with Fuji Xerox Direct.

DocuWorks e

The entered User ID is registered to DocuWorks online user
L registration.

To activate the license, enter the User ID registered to Fuji

Xerox Direct.

| x|

4

Your license is activated. When the dialog box indicating a successful activation appears, click [OK].

Important * An active Internet connection is required to activate the license. If the activation
fails, "Trial Edition" will appear at start of DocuWorks. To run the trial edition as the
licensed edition, refer to 4.2 "Online Activation" (P.38) to activate the license. To
check whether your license is activated, refer to 4.1 "Checking License Status"
(P.35).
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* If you click [Cancel] in the dialog box for step 14, a dialog box is displayed to
confirm whether you want to cancel the license activation. Clicking [No] returns
you to the dialog box for step 14. Clicking [Yes] allows you to install DocuWorks as
"trial edition with the serial number registered". To run the trial edition as the
licensed edition, refer to 4.2 "Online Activation" (P.38) to activate the license.

* If you type an incorrect user ID or password five times in the dialog box for step
14, your password is locked. In case you forgot password, access the following
URL via a web browser and reset the password using Fuji Xerox Direct.
https://direct.fujixerox.com/ap2/resetpassword/apply_form

Note If clicking [New Registration] in the dialog box for step 14 does not initiate connection to
the Fuji Xerox Direct website, access the following URL via a web browser:
https://direct.fujixerox.com/ap2/register/ols/

Install the individual software components that are required to run DocuWorks.

The installer for each of the following applications will be started sequentially: DocuWorks PDF

Creator. Follow instructions on the screen to go through installation.

* When the screen prompting you to restart your computer appears
Restart your computer and log in using the same user account that was used during
the installation. Perform steps 1 through 3 again, and click [Cancel] on the [Welcome
to DocuWorks 8 Setup Wizard] screen. After clicking [Finish] on the [DocuWorks 8
Setup has been aborted.] screen, the installation of the next software component
automatically starts.

* When the screen prompting you to restart your computer does not appear
The installation of the next software component automatically starts.

Important The screen prompting you to restart the computer appears when there is a file that
cannot be overwritten. However, the installation can be completed if you restart the
computer accordingly.

Note  If .NET Framework 3.5 has not been installed on the computer, the DocuWorks
installer will install .NET Framework 3.5.

e If NET Framework 4 has not been installed on the computer, the DocuWorks
installer will install .NET Framework 4.

The installation of DocuWorks has now been completed. Go to 3.1 "Executing the Configuring of
Personal Settings" (P.26).
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2.2 Installing DocuWorks Viewer Light 8

DocuWorks Viewer Light is free software to view DocuWorks files. This application enables
you to view the DocuWorks files even in an environment that does not have DocuWorks
installed.

Note You do not have to install DocuWorks Viewer Light on a PC which has DocuWorks
installed.
You can view and print DocuWorks files, search and copy a character string, jump by using
the link annotation, extract original data, and view DocuWorks files on a web browser.
However, you cannot edit DocuWorks files.

Important If DocuWorks Viewer Light for Web 5.x has been installed, do not uninstall it. Just
overwrite it with DocuWorks Viewer Light 8.

Note DocuWorks Viewer Light for Web is software provided with the earlier versions of

DocuWorks. In this version, the functions of DocuWorks Viewer Light for Web have
been integrated into those of DocuWorks Viewer Light.

How to Install DocuWorks Viewer Light 8

1  Close all the active applications and insert the DocuWorks 8 installation media into the
media drive.

The autorun screen appears automatically.

Note If autorun screen does not appear, execute "autorun.exe" under the "autorun” folder in
the installation media.

2 Click the language for the installation.

3  Click the button on the left of [DocuWorks Viewer Light 8].

Note If the [User Account Control] dialog box appears, click [Continue].
‘=] DocuWorks 8 = = ==
DocuWorks 8

| Setup Guide |

| Installation of DocuWorks 8
L ) Ingtall Docuiworkes 8.

Installation of bundled application
|’ | Docuworks Tray 2
X ) Install Diocuwiorks Tray 2.

| Docuworks OCR Multi Language Package
N ) Inztall Diocuwforks OCR Multi Language Package.

( " Docuworks Extended Folder for Working Folder 1.5
|\ ) Inztall Diocuwiorks Extended Folder for Working Folder 1.5,

|' " Docuworks Extended Folder for SharePoint Services 1.0
) ) Install Docutwiorks Estended Folder for SharePaint Services 1.0,

Installation of application for browsing
Jocuw orks Yiewer Light 8
aztall a free toal that can display / print Docuiworks file.

FUJI XErOX @) | RelaseNoe | [ ovoRoM | [ Quit
"
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4 Click [Next].

' Al
ﬂ DocuWorks Viewer Light 8 Setup M

Welcome to DocuWorks Viewer Light 8 Setup
Wizard

DocuWorks Viewer Light 8 will be installed. Click Mext to
continue,

< Back Eomext> | Cancel

h

The [License Agreement] dialog box appears.

5 Verify information displayed in the DocuWorks Viewer Light licensing agreement. If you
agree to the licensing conditions, select [| accept the terms in the license agreement],
and click [Next].

6 Selectthe setup type, and click [Next].

The default is [Standard].
* [Standard]
Install items as the default settings. Proceed to Step 9.
¢ [Custom]
Install items changing the default settings. Proceed to Step 7.

' Al
ﬂ DocuWorks Viewer Light 8 Setup M
Setup Type -
Choose the setup type that best suits your needs, FUJI Xerox Q)

Flease select a setup type.

Installation will be executed with standard settings.

‘You can select an installation destination and option settings. This
option is recommended for users who are familiar with the product.

. J

Installshield

[ < Back |[ Next = ] Cancel
> 4
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7  Select the installation destination folder, and click [Next].

‘_'@ DocuWorks Viewer Light 8 Setup @
Destination Folder P
Click Mext to install to this folder, or dick Change to install to a different FUJI Xerox !)
folder,
G Install DocuWorks Viewer Light 8 to: A
C:'Program Files\Fuji ¥erox\DocuwWorks\
J
InstallShield
[ Mext = |) Cancel ]
Note It is recommended to set the same folder as that of the installation destination of

DocuWorks 8.

8  Select the browser with which you want to display DocuWorks documents, and click
[Next].

) DocuWorks Viewer Light 8 Setup @

Display In Browser Options
‘You can choose to display DocuVWorks document in the browser,

FUJI XEroX @)

Select the browser to display DocuWorks document.

Google Chrome, Mozilla Firefox

Installshield

[ < Back ][ Next = J Cancel
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9 cConfirm the settings, and click [Install].

' Al
ﬂ DocuWorks Viewer Light 8 Setup M

Ready to Install the Program

FUJI Xerox @)

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

DocuWorks Viewer Light 8 installation destination:

C:\Program Files\Fuji Xerox\DocuWorks),

Display DocuwWerks Document in Browser
Windows Internet Explorer: Display
Google Chrome, Mozilla Firefox: Display

InstallShield

|l) Cancel

10 ciick [Finish].

' Al
ﬂ DocuWorks Viewer Light 8 Setup M

Setup Wizard has completed.

DocuWWorks Viewer Light 8 has been installed successfully. Click
Finish to dose Wizard.

< Back Cancel

Important When the screen prompting you to restart your computer appears, make sure to
restart your computer, and log in using the same user account that was used during
the installation. The screen prompting you to restart your computer appears when
there is a file that cannot be overwritten. However, the installation can be completed
if you restart the computer accordingly.
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3 Executing the Configuring of
Personal Settings

When using DocuWorks for the first time, you need to individually specify the location of the
Desk folder, and location of the folder for temporary files to be used for each Windows user
account. You can use DocuWorks only after Personal Settings are complete. The contents
of the Personal Settings can be changed later.

This chapter describes how to configure Personal Settings and to change the settings later.

3.1 Executing the Configuring of Personal Settings

How to configure the Personal Settings differs depending whether DocuWorks is newly
installed or upgraded from a previous version.

Newly Installing DocuWorks

When you run DocuWorks for the first time after installation, the DocuWorks Personal
Settings Tool starts automatically, and the screen shown in step 2 appears.

1 From the Windows [Start] menu, select [All Programs] > [Fuji Xerox] > [DocuWorks] >
[DocuWorks Personal Settings Tool].

The [DocuWorks Personal Settings] dialog box appears.

2  Click [Next].

7 DocuWorks Personal Settings [-EE-J

You cannet use DocuWorks until these settings are

You need to complete the User's Personal Settings.
configured.

Main setting tems
- Desk folder destination
- Temporary folder destination

. Please follow the on-screen instructions.

< Back [ Next > ] Cancel || Help
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Select either [Standard settings] or [Customize settings], and click [Next].

The default is [Standard settings].

[l Select install method

S5)

Please choose one of the following options:

(71 Customize settings

= (T ]i Cancel | [ Heb

* [Standard settings]

Configure Personal Settings in the default values. Proceed to Step 8.

* [Customize settings]

Configure Personal Settings changing the default values. Proceed to Step 4.

Select a location to create a Desk folder,

This is the folder where the user folders

and click [Next].

to be used on Desk will be created. Sufficient

free space is required since the user data will be stored here.
The default is "<Personal folder>\Fuji Xerox\DocuWorks\DWFolders".

[l Desk Folder Setting

S5)

Specify the folderto be used by DocuWorks Desk.
7
Cument settings:

-

(Not cumenthy set)

MNew setup value:

ain User\Documents'\Fuii Xenox\DocuWorks\DWW Foldes

J

f p—
[ <Back{J[ MNet> | ) Cancel | [ Heb |

Note

¢ The location of the <Personal folder> is as follows:
e C:\Users\user name\Documents

* If you specify Personal Settings for the first time after upgrading an earlier version,

a Desk folder is, by default,
version was stored.

in the location where the Desk folder of the earlier
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5

Select a location to create a temporary file folder, and click [Next].

This is the folder that DocuWorks program uses temporarily during operation.
The default is "<Application Data folder>\Fuji Xerox\DocuWorks\DWTemp".

[zl Temporary File Folder Setting [é]

. Specify the folder for temporary files.
4 )
Cument settings:

(Mot cumenthy set)

MNew setup value:

N\
[ <Back (| Nea> | ) Cancel | [ Hep |

Important * Do not install DocuWorks to the following locations. Otherwise the software may
malfunction.

¢ Directly under the drive such as "C:\"
¢ Removal media such as CD-R/RW, MO, or memory card
* If you specify a network folder, it cannot be shared between two or more users.

b

Note The location of the <Application Data folder> is as follows:
» C:\Users\user name\AppData\Roaming

Select the Office application in which the DocuWorks Creator for Microsoft Office is
enabled, and then click [Next].

If you enable the DocuWorks Creator for Microsoft Office, the [Convert to DocuWorks]
button will be created on the toolbar of the selected Microsoft Office application.

By default, all of them are checked.

m DocuWorks Creator for Microsoft Office Settings [éj

Select the Cffice application in which the DocuWorks
Creator for Microsoft Office is enabled

Microsoft Excel
Microsoft PowerPoint

- DocuWorks Creator for Microsoft Office is an add+n
 (advanced) feature of Microsoft Office that allows the user
to create DocuWorks documents by adding buttons to
Microsoft Word, Microsoft Excel, and Microsoft

- PowerPoint documents.

N\
[ <Back (| Nea> | ) cCancel | [ Hep
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7 Select the shortcut to be created, and click [Next].

If selecting [[Send To] menu], DocuWorks Printer will be added on the [Send To] menu
displayed when right-clicking on Windows Explorer.

If selecting [Quick Launch toolbar], [Starting DocuWorks Desk] will be added on the
Quick Launch items displayed on Windows Taskbar.

By default, all of them are checked.

i B
E Create Shortcut M

Select the shortcut menu to be created.
Neselect the shartci# mem nat ta he created

U

Create the shortcut to DocuWorks Printer in the [Send
To] menu.

Quick Launch toolbar

Create the shortcut to start DocuWorks Desk in the
Quick Launch toolbar.

N\
[ <Back (| Nea> | ) cCancel | [ Hebp

b

8  Confirm the settings, and click [Next].

r B
[l Check the setup contents M

Do you want to make the User's Personal Settings as
shown below?

Desk Folders Directory Location: -
ClUsers\Main User'\Documents'Fuji Xerox [
Temporary File Folder:
ClUsers'\Main User' AppDiata® Roaming'Fu
Desk Plug4n Setting: i
Cortinue to use 5
Viewer template/drawing tool, annotation tool settings
Continue to use
Enable Docu\Works Creator for Microsoft Cffice:
Microsoft Word
Microsoft Excel
Microsoft PowerPoint

9  Click [Finish].

i My
[ Settings complete M

Personal Settings completed successfully.

Cancel Help
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Upgrading DocuWorks

This section explains how to configure Personal Settings when upgrading an earlier version.

1  Follow the procedures to step 3 under "Newly Installing DocuWorks" on page 26.

2 i you selected [Standard settings] in step 3 under "Newly Installing DocuWorks" on
page 27, perform steps 8 and 9 on page 29.

Personal Settings are configured.

If you selected [Customize settings] in step 3 under "Newly Installing DocuWorks" on page 27, follow
the steps 4 and 5 on page 27 before following steps 3 through 5 on page 30.

3 Keep the check mark to [Continue to use] if you continue to use the same settings for
plug-in that you customized prior to upgrading.*1 2
Remove the check mark if you wish to replace them with the standard settings of this

version. 2
Click [Next].

7 Inherit the Desk setting information [ﬁj

found.

Previously installed Desk plug-in setup information was
Do you want to keep your old settings?

e o neep your old Desk plug-in
settings. Clear the check box to overwrite with default
values.

| :ﬁackm Cancel | [ Hep |

Tf [Conversion to PDF] has been added to [Current Plug-in Menu] on the [Plug-in
Setting] dialog box on Desk, the name of the [Conversion to PDF] plug-in will be
inherited. [Conversion to PDF] on [Available Plug-ins] will be changed to [Conversion
to PDF(Adobe PDF)].

"2 \When you upgrade from DocuWorks 7.3 or earlier, regardless of the [Continue to use]
setting, [Conversion to PDF(DocuWorks PDF Creator)] will be added to [Available
Plug-ins] and [Current Plug-in Menu] in the [Plug-in Setting] dialog box on Desk.
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4 Keep the check mark to [Continue to use] if you continue to use the same settings for
annotation tool, Template tool, or Drawing tool that you customized prior to upgrading.
Remove the check mark if you wish to replace them with the standard settings of this

version.
Click [Next].

533 Inherit the Annotation setting information @

Previously installed annotation tool, Template tool or
Drawing toal was found.
Do you want to keep your old settings?

i, L Lo, wus, o reep your old Tool settings. Clear
the check box to overwrite with default values.

N\
[ <Back (| Nea> | ) Cancel | [ Hep |

5 Follow the procedures after step 6 under "Newly Installing DocuWorks" on page 28.

Personal Settings are configured.
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3.2 Changing the Personal Settings

If you want to change the Desk folder destination to another folder in case of insufficient free

hard disk space or the like when using DocuWorks, use the DocuWorks Personal Settings
Tool.

DocuWorks Personal Settings Tool allows you to change the settings of Desk folder
destination, temporary file folder destination, and DocuWorks Creator for Microsoft Office.

1  From the Windows [Start] menu, select [All Programs] > [Fuji Xerox] > [DocuWorks] >
[DocuWorks Personal Settings Tool].

The [DocuWorks Personal Settings] dialog box appears.

2 Select [Change setting], and click [Next].

r -
[ DocuWorks Personal Settings @
2 You can modify or recover contents of the User's Personal
) Settings.
Main setting items

- Desk folder destination
- Temporary folder destination

[ Select operation contents.

3 Specify the Desk folder in [New setup value], and click [Next].

[ Desk Folder Setting @

E Specify the folder to be used by DocuWorks Desk.

Cument seftings: )

C:iUsers\Main User\DocumentsFuji ¥eroxc\DocuWarks'
MNew setup value:

jgin User\Documents'\Fuji Xero\DocuWorks\DWW Folders

=)

f p—
[ <Back (| Net> | ) Cancel | [ Hep |

Note If the location of the Desk folder is changed, the settings of link folder, annotation tool
file, Electronic Signature Case data file will be inherited to the new Desk folder.
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Specify the folder where the temporary files will be generated in [New setup value], and

click [Next].

i My
|| Temporary File Folder Setting u

Specify the folder for temporary files.

(" ]

Cument settings:
Cilsers\Main User'AppData“.RoamingFuji Xerox\DocL
MNew setup value:

=r'App Data'Roaming\Fuji Xerox\DocuWorks \DW Temp

Browse...

~N

5  Select the Office application in which the DocuWorks Creator for Microsoft Office is

6  Select the shortcut to be created, and click [Next].

enabled, and click [Next].

' ™
[i7l DocuWorks Creator for Microsoft Office Settings u

Select the Cffice application in which the DocuWorks
Creator for Microsoft Office is enabled

Microsoft Excel
Microsoft PowerPoint

DocuWorks Creator for Microsoft Office is an add4n

. (advanced) feature of Microsoft Office that allows the user
to create DocuWorks documents by adding buttons to
Microsoft Word, Microsoft Excel, and Microsoft
PowerPoint documents.

f p—
[ <Back (| Ne> | ) Cancel | [ Hep

i B
E Create Shortcut u

Select the shortcut menu to be created.
Deselect the shortcut menu not to be created.

U
Create the shortcut to DocuWorks Printer in the [Send
To] menu.

Quick Launch toolbar

Create the shortcut to start DocuWorks Desk in the
Quick Launch toolbar.

N\
[ <Back (| Nea> | ) cCancel | [ Hebp
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7  Confirm the settings, and click [Next].

' ™
[i7] Check the setup contents u

Do you want to make the User's Personal Settings as
shown below?

Desk Folders Directory Location:
CMUsers'Main User\Documents'\Fuji Xenox
Temporary File Folder:
C:MUsers'\Main User'AppDiata“Roaming'Fu
Desk Plug4n Setting:
Continue to use
Viewer template/drawing tool, annotation tool settings
Continue to use
Enable DocuWorks Creator for Microsoft Cffice:
Microsoft Word
Microsoft Excel
Microsoft PowerPoint

T F—— 3

-

<Back ([ THed> ] ) cancel | [ Heb

8  Click [Finish].

r B
[l Settings complete u

Personal Settings completed successfully.

=
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4 Activating a License

In order use DocuWorks as a licensed edition, you need to activate the license immediately
after installation of DocuWorks. This chapter describes how to activate the license in case
you have cancelled activating the license immediately after installation or the license has
expired. It also gives instructions on how to activate the license when upgrading from the
trial to the licensed edition. If you have no serial number, you must first purchase a license
by following the instructions described in 4.4 "Upgrading from the Trial to the Licensed
Edition" (P.57).

4.1 Checking License Status

Follow the procedure below to check the status of license for DocuWorks installed.

1 Log on as a user who belongs to the Administrators group.

2 From your Windows Start menu, go [All Programs] > [Fuji Xerox] > [DocuWorks] and
click [License Management Screen] to open [License Activator] (License Management

Screen).
Important If the [User Account Control] dialog box appears, click [Yes].
Note The title bar of the License Management Screen shows [License Activator].

* When your trial period is expired:
If you try to open DocuWorks Desk or DocuWorks Viewer, a dialog box appears
prompting you to activate your DocuWorks. Click the [License Management Screen]
button in this dialog box.

[ DocuWorks (23w

Unable to execute as licensze haz not been activated.

Buy License. .. | | Activate License [G Lizense Management Screen... D[ 0k
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* When your trial period is not expired:

36

Launch DocuWorks Desk or DocuWorks Viewer, and go [Help] > [License
Management] and click [License Management Screen] to open [License Activator].

DocuWorks Desk

File Edit View Document Page To r
. 7 Docuworks Help
) | =
= Fuji Xerox Web Pa
= EE

License Agreemen

About DocuWorks

{T DocuWorks Desk
= 5 User Folder
] Let's Start DocuWorks \

F1
ge

t

. License Management  »

(=18
Buy License...

Activate License

License Management Screen..

oS

[ Sample Doc - DocuWorks 8
[ Link Folder
4 Recycle Bin
i Meighborhood
[EF Mailbox
At Search Result
5 Attribute Filter

When you display the License Management Screen for the first time, the [License Agreement] dialog

box appears.

Verify the information displayed in the [License Agreement] dialog box, and click

[accept].

Check the license activation status.

License Activator

Thank you For installing Fuiji ¥erox product.
‘fou can perform license related operation For Fuji erox product using this application,

Reqister License

Delete License

Registered License

Open in Another Screen

Product Mame Serial Mumber

Docutorks

License Status

Activated

Wersion Information Advanced Features

Exit:

There are three possible status for your license.

» The serial number is displayed, and [Activated] is displayed under [License Status]
The license of the product is already activated for use as licensed edition.
+ Although the serial number is displayed, [Unactivated] is displayed under [License

Status]

The product is running as "trial edition with the serial number entered". Activating the
license allows you to use the product as licensed edition.
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* [Product Name], [Serial Number], and [License Status] fields are all empty
The product is running as trial edition. You can use the product as licensed edition by
entering the serial number and activating the license.

5 ciick [Exit].
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4.2 Online Activation

Activating via the License Activation Screen

You can use the license activation screen to enter the serial number, which is printed on the
license certificate enclosed in the product package, to activate your license.

1 Log on as a user who belongs to the Administrators group.

2 Open the [License Management] screen.

Important If the [User Account Control] dialog box appears, click [Yes].

Note The title bar of the License Management Screen shows [License Management].

* When your trial period is expired:
If you try to open DocuWorks Desk or DocuWorks Viewer, a dialog box appears
prompting you to activate your DocuWorks. Click [Activate License] button in this
dialog box.

-,

[ Crocu'Works ==

Unable to execute as license has not been activated.

| Buy Licensze. . |G Activate License D |I__ic:ense ki anagement Screen...| [ 0k

* When your trial period is not expired:
Launch DocuWorks Desk or DocuWorks Viewer, and go [Help] > [License
Management] and click [Activate License].

|£\ DocuWorks Desk ' \= @
Ele Edit “iew Document Page Too

? Docuworks Help F1

|ﬂﬂ_\ T
— = — Fuji Xerox Web Page  »
=& B =5 M =]

J==) License Agreement

License Management  » Buy License..

About DocuWorks

Activate License

{T DocuWorks Desk
= [E5 User Folder License Management Screen...
3 Let's Start DocuWorks & Y,
Sample Doc - DocuWorks 8
[& Link Folder
19 Recycle Bin
# Fi Neighborhood
[EF Mailbox
# Bfl Search Result
= [ Attribute Filter

The [License Agreement] dialog box appears.
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3 Enter the serial number printed on the license certificate, which is enclosed in the
product package, and click [Next].

. 5
License Management &J

Enter the serial number and click [Mest].

(ﬁerial Mumber
| .

’ [ Nest | I Cancel I

h

Note * If you have already entered the serial number during installation, this screen does
not appear.

* If you enter the serial number for an Upgrade License, the installer checks the
serial number and then displays a dialog box to enter the serial number for
DocuWorks 6.x/7.x. Enter the serial number for DocuWorks 6.x/7.x and click
[Next].

-
License Management &J

If you have a serial number of one Docuiwiorks B.0, 7.0, 7.1, 7.2 and 7.3 of, available as a
commercial product version when | have you enter the serial number of them.

r Serial Number J
[ ] | | |

4 Enter your [User ID (E-mail address)] and [Password], and click [OK].

* In [User ID (E-mail address)], enter your user ID (e-mail address) registered with Fuji
Xerox Direct. You must enter the whole e-mail address including the part to the right
of the at sign (@).

* In [Password], enter the password registered with Fuji Xerox Direct.

+ Clicking [New Registration] starts your web browser and connects to the user
registration page on Fuji Xerox Direct. It is advisable to complete user registration in
advance by following the instruction in "User Registration with Fuji Xerox Direct"

(P.10).

If you prefer not to receive e-mails about the product information, deselect the check
box.

License Management @

Enter the User 1D [E-mail address] and Password if vou have already registered for the Fuji <erox
Direct.

='when authenticating for the very first time or even when e-mail delivery is not required., it will be
dizplayed with a check mark. [f pau do nat wish to receive e-mail, uncheck the selection.

Uszer ID

Fui T le.
(E-mail address] uji_T arof{@example. com

Pazzword sssesses

E-mail deliverny iz required for information related ta this product

If you have not registered, click [Mew Registration] to register at the web site.

)
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Important If you enter your former user ID (a 10 digit number) you registered for DocuWorks 7
or earlier, the dialog box shown below is displayed. Click [OK], and enter your user
ID (e-mail address) registered with Fuji Xerox Direct.

DocuWorks 8

The entered User ID is registered to DocuWorks online user
! “ registration.

To activate the license, enter the User ID registered to Fuji

Xerox Direct.

Your license is activated. When the dialog box indicating a successful activation appears, click [OK].

Important If you type an incorrect user ID or password five times, your password is locked. In
case you forgot password, access the following URL via a web browser and reset
the password using Fuji Xerox Direct.
https://direct.fujixerox.com/ap2/resetpassword/apply_form

Note If clicking [New Registration] does not initiate connection to the Fuji Xerox Direct

website, access the following URL via a web browser:
https://direct.fujixerox.com/ap2/register/ols/

Activating via the License Management Screen

Start the License Management Screen and activate the license by entering the serial
number.

Generally, activation is performed online. If your network environment does not allow the
License Management Screen to communicate with the Fuji Xerox license authentication
server, you can select an activation method that uses the license activation information file.

Entering a Serial Number on the License Management Screen

On the License Management Screen, enter the serial number printed on the license
certificate, which is enclosed in the product package.

1 Log on as a user who belongs to the Administrators group.

2 From your Windows Start menu, go [All Programs] > [Fuji Xerox] > [DocuWorks] and
click [License Management Screen] to open [License Activator] (License Management

Screen).
Important If the [User Account Control] dialog box appears, click [Yes].
Note The title bar of the License Management Screen shows [License Activator].

* When your trial period is expired:
If you try to open DocuWorks Desk or DocuWorks Viewer, a dialog box appears
prompting you to activate your DocuWorks. Click [License Management Screen]
button in this dialog box.
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DocuWorks ==

IInable to execute as license has not been activated.

[ Buy Licensze. . ] [ Activate License ](’I__icense ManagementScreen...D[ 0k

* When your trial period is not expired:
Launch DocuWorks Desk or DocuWorks Viewer, and go [Help] > [License
Management] and click [License Management Screen] to open [License Activator].

[E=5|EER =)

DocuWaorks Desk

7
Fle Edit WYiew Document Page Too
m . ? DocuWorks Help F1

Fuji Xerox Web Page  »

@ @ [ Ifl @J License Agreement @J'

3 Buy License...

N\

Eﬂ

About Docuworks

{1 DocuWorks Desk Activate License

& [ User Folder License Management Screen...

[ Let's Start DocuWorks \ )
[5) Sample Doc - DocuWorks 8

(& Link Folder
18] Recycle Bin

i Neighborhood
[EF Mailbox

Bl Search Result

SF Attribute Filter

When you display the License Management Screen for the first time, the [License Agreement] dialog
box appears.

3 Verify the information displayed in the [License Agreement] dialog box, and click
[accept].

The License Activator screen appears.

4  Click [Register License].

License Activator

Thank you fFor installing Fuji ¥erox product.,
‘¥ou can perform license related operation For Fuji Xerox product using this application.

Reqister License Delete License
Registered License Qpen in Another Screen
Product Mame Serial Mumber License Status

Wersion Information Advanced Features Exit
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5 select [Serial Number (Text Entry)], enter the serial number printed on the license
certificate, which is enclosed in the product package, and then click [Add].

License Activator

License Activation (1/6)

Enter the license serial number,

(®) Serial Mumber (Enter Tesxt)

e e e e e e e e e [l N

Delete

() 5erial Mumber (Import Fils)

Erowse. ..

= Back Cancel

The serial number you entered is added to the list.

6 Click [Next].

7  Select one of the activation methods and click [Next].

You can select either one of the following activation methods:

* [Use the Internet to Activate License (Recommended)]
In this method, the License Management Screen communicates with the Fuji Xerox
license authentication server via the Internet to perform license activation. This
method is used in most cases.
If you select this option, go to "Activating via the Internet" (P.43).

* [Use File to Activate License]
If your network environment does not allow the License Management Screen to
communicate with the Fuji Xerox license authentication server, select this option.
In this method, first you need to upload the file, in which the serial number and
information such as your e-mail address are encrypted, to Fuji Xerox Direct. Then,
download a license file from Fuji Xerox Direct and import it into the License
Management Screen to activate your license.
If you select this option, go to "Activating Your License with File" (P.47).

License Activator

License Activation (3/6)

Select the license activation method.

(®)Use the Internet to Activate License (Recommended):

Select this if your computer is connected to the Internet.

(O Use File to Activate License

Select this if your computer is unable to connect to the Internet.
License Activation nformation file output will be performed.

< Back Mext > Cancel
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Activating via the Internet

The following are the subsequent steps to be performed when you select [Use the Internet
to Activate License (Recommended)] (p. 42) in the License Management Screen.

1 Onthe License Activator (License Management Screen), click [Register License].

License Activator
Thank you For installing Fuji ¥erax product.
‘fou can perform license related operation For Fuji %erox product using this application.
Reqister License Delete License
Registered License Cpen in Another Screen
Product Mame Serial Number License Status
Yersion Information Advanced Features Exit

2  Perform the following steps:

* When entering the serial number manually
1) Select [Serial Number (Enter Text)].

2) Enter the serial number.
The serial number is printed on the license certificate that is enclosed in the
product package.

3) Click [Add].
The serial number you entered is added to the list.

4) Click [Next].

License Activator

License Activation (1/5)

Enter the license serial number,

(®) Serial Murmber (Erter Text) (1 ) (2) (3)
] - ][] - [ ] - [ ] - [

Dielete

() Setial Mumber {Impart File)

Etowse. ..
(4)
= Back. Cancel
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* When entering the serial number from a file

3

By saving the serial number to a file in advance, you can load it into License Activator
from the file. To describe multiple serial numbers in the file, make sure each of the four-
digits is delimited by a hyphen (-), and each serial number is located on a separate line,

delimited by a line break, as shown below.
1111-2222-3333-4444-5555-6666
2222-3333-4444-5555-6666-7777

1) Select [Serial Number (Import File)].

2) Click [Browse] to select the file.

Note You can also manually enter the path to the file where serial numbers are described.

3) Click [Next].

License Activator

License Activation (1/6)

Enter the license serial number,

() 5erial Mumber (Enter Test)

Celete

(2)

= Back

—
w
N

Erowse. ..

Cancel

Perform the following steps:

1) Select [Use the Internet to Activate License (Recommended)].

2) Click [Next].

License Activator

License Activation (3/6)

Select the license activation method.

(®){Use the Internet to Activate License (Recommended):

(1)

(O Use File to Activate License

Select this if your computer is connected to the Internet.

Select this if your computer is unable to connect to the Internet.
License Activation information file output will be performed.

< Back

(2)

Next >

Cancel
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4

Perform the following steps:

1) Specify the e-mail address and password you registered with Fuji Xerox Direct.

2) In order to receive up-to-date information via e-mail, select [E-mail delivery is
required for information related to this product].

Note Not to receive up-to-date information, clear the check box.

3) Click [Next].
License activation is performed via the Internet.

License Activator

License Activation (4/6)

Enter the Fuji Xerox Direct account information.

E-mail Address: | |

Passward: | [R—— |
E-mail delivery is reguired For information related If You Hawe Forgotten
(2) ko this product, Yiour Password

If you do not have a Fuiji Xerox Direct account, regisker For one ak "Membership
Registration” in the Following Fuji ¥erox Direct page.

Memnbership Registration

(3)
= Back Cancel

When the license activation is complete, click [Completed].

License Activator

License Activation (6/6)

License activation processing has completad.

Activation Result Setial Number Status

Successful

Completed
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6 Check the registered license, and click [Exit].

License Activator

Thank you For installing Fuji ¥erox product.
‘ou can perform license related operation For Fuji Xerox product using this application,

Reqister License Delete License
Registered License Open in Another Screen
Product Mame Serial Mumber License Status
Docuworks Activated

Wersion Information Advanced Features Exit

46
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4.3 Offline Activation

Activating Your License with File

The following are the subsequent steps to be performed when you select [Use File to
Activate License] (p.42) in the License Management Screen.

® Outputting a License Activation Information File (p.47)
® Uploading the License Activation Information File (p.51)
® Downloading a License File (p.53)

® Activating Using a License File (p.54)

Outputting a License Activation Information File
1 Log on as a user who belongs to the Administrators group.

2 From your Windows Start menu, go [All Programs] > [Fuji Xerox] > [DocuWorks] and
click [License Management Screen] to open [License Activator] (License Management

Screen).
Important If the [User Account Control] dialog box appears, click [Yes].
Note The title bar of the License Management Screen shows [License Activator].

* When your trial period is expired:
If you try to open DocuWorks Desk or DocuWorks Viewer, a dialog box appears
prompting you to activate your DocuWorks. Click [License Management Screen]
button in this dialog box.

[ DocuWorks @

IInable to execute as license has not been activated.

Buy Licensze. .. | | Activate Licenze |GI__ic:en$e ManagementScreen..D [ Qk
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* When your trial period is not expired:
Launch DocuWorks Desk or DocuWorks Viewer, and go [Help] > [License
Management] and click [License Management Screen] to open [License Activator].
DocuWaorks Desk N E@
Fle Edit Wiew Document Page Tox r
@ u ? DocuWorks Help F1

o m Fuji Xerox Web Page  »
@ lgj l—J License Agreement @J'

3 Buy License...

]
2]

J About Docuworks

{1 DocuWorks Desk Activate License

& [ User Folder License Management Screen...

[ Let's Start DocuWorks \
[5) Sample Doc - DocuWorks 8

(& Link Folder
18] Recycle Bin

i Neighborhood
[EF Mailbox

Bl Search Result

SF Attribute Filter

When you display the License Management Screen for the first time, the [License Agreement] dialog
box appears.

3  On the License Activator (License Management Screen), click [Register License].

License Activator

Thank you For installing Fuji Xerox product.
‘ou can perform license related operation For Fuji ®erox product using this application.

Reqister License Delete License
Registered License Open in Another Screen
Product Marme Serial Mumber License Status

Wersion Information Advanced Features Exit
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4

Perform the following steps:

* When entering the serial number manually

1) Select [Serial Number (Enter Text)].

2) Enter the serial number.
The serial number is printed on the license certificate that is enclosed in the
product package.

3) Click [Add].
The serial number you entered is added to the list.

4) Click [Next].

License Activator
License Activation (1/5)

Enter the license serial number,

(®) Serial Mumber (Enker Text) (1 ) (2) (3)
=] F] =] =] )

Celete

() Setial Mumber {Impart File)

Etowse. ..
(4)
= Back. Cancel

* When entering the serial number from a file
By saving the serial number to a file in advance, you can load it into License Activator
from the file. To describe multiple serial numbers in the file, make sure each of the four-
digits is delimited by a hyphen (-), and each serial number is located on a separate line,
delimited by a line break, as shown below.
1111-2222-3333-4444-5555-6666
2222-3333-4444-5555-6666-7777

1) Select [Serial Number (Import File)].
2) Click [Browse] to select the file.
Note You can also manually enter the path to the file where serial numbers are described.

3) Click [Next].

License Activator

License Activation (1/8)

Enter the license serial number,

() Serial Murnber (Enter Text)

Delete

(2)

Erowse. ..

{2\
V)

< Back. Cancel
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5 Performthe following steps:

1) Select [Use File to Activate License].
2) Click [Next].

License Activator

License Activation (3/6)

Select the license activation method.

(") Use the Internet to Activate License (Recommended)

Select this if your computer is connected to the Internet.

(1)

Select this if your computer is unable to connect to the Internet.
License Activation information file output will be performed.

(2)

< Back Mext > Cancel

6 Perform the following steps:

1) Enter the e-mail address and password you registered with Fuji Xerox Direct.

2) In order to receive up-to-date information via e-mail, select [E-mail delivery is
required for information related to this product].

Note Not to receive up-to-date information, clear the check box.

3) Click [Next].

License Activator

License Activation (4/6)

Enter the Fuji Xerox Direct account information.

E-mail Address: | |

Password; | sossssnne |

E-mail delivery is required for information related
(2) ko bhis product,

3)
< Back. Cancel
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7 Click [Browse], specify the Output Destination and file name for the license activation
info file, and then click [Next].

License Activator

License Activation {56

Specify the output destination For license activation info file.

License Activation Information File Output Destination

| Etowse. ..

= Back. Cancel

Note The default Output Destination is the desktop. The default file name is
"activationinfor.dat".

The license activation info file is output to the specified destination with the specified file name.

8  Click [Finish].

Uploading the License Activation Information File
Upload the license activation information file to Fuji Xerox Direct.

1 use your web browser to visit the URL for the page to activate an uploaded file, located

in "Fuji Xerox Direct" at:
https://direct.fujixerox.com/ap2/license/bulk_activation/upload?proc=activation

A screen to log in to "Fuji Xerox Direct" appears.

2 Filin [User ID(E-mail Address)] and [Password], and click the [Login] button.

A page for you to upload a file appears.
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3 Check that the [Activate] tab is selected, and click the [Browse] button.

FUJI Xerox 6;\ Fuji Xerox Direct Skt ~ Al

ContactUs  Site Map  Home

Service List ne Purchase

Home = Service List = Operation Support Service > Software License Management = Upload File

License Activation/Activat Upload File
ion Cancellation (By File)
Select the Activate tab to activate your license, and the Cancel Activation tab to cancel it

> Upload File

ilssitinlen ﬁ CencetAdiaton

# Click the Browse button, select the file to upload, and send. You can also drag and drop the file
* You can upload up to 10 files at one time_ If there are 11 or more files, send them in multiple batches

> Information on License Act

ivation/Activation Cancella

tion (By File) * When replacing your computer, complete license activation cancellation first before activating the license. If you activate the
license without canceling license activation, there may not be enough licenses.

 |f an emror occurs, refer to * Information on License Activation/Activation Cancellation (By File) " for "Error Handling”™

> Inquiry on License Activati .
on/Activation Cancellation I File
(By File)

Drag and drop your file here.

4  Select the exported license activation information file, and click the [Open] button.

Note You can also drag and drop the license activation information file directly to upload it.

5  Check that the file name is displayed in the File field, and click the [Send] button.

FUJI Xerox ‘:\ Fuji Xerox Direct R

I
Contact Us Site Map Home

Se

ice List Online Purchase

Home = Service List > Operation Support Service » Software License Management > Upload File

License Activation/Activat Up[oad File
ion Cancellation (By File)

Select the Activate tab to activate your license, and the Cancel Activation tab to cancel it
> Upload File

’ prDCESSing Resuttist ﬁ Cance' Adivaﬁon

# Click the Browse button, select the file to upload, and send. You can also drag and drop the file.

» Information on License Act

ivation/Activation Cancella ® You can upload up to 10 files at one time. If there are 11 or more files, send them in multiple batches
tion (By File) * When replacing your computer, complete license activation cancellation first before activating the license. If you activate the
license without canceling license activation, there may not be enough licenses.
oLt oo =l b tH Lio th oo At o4 i ot 2o Ll = for ~F. Lo dl
> Inquiry on License Activati .
oniActivation Cancellation I File activationinfor(Fuji Tar).dat | Delete Browse
(By File)

Drag and drop your file here.

The message "Received file processing request." appears.
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Downloading a License File

When you receive an email notifying you of the completion of the license activation
processing, download a license file from "Fuji Xerox Direct."

1 You will receive an email sent from "Fuji Xerox Direct" notifying you of the completion
of the license activation processing.

2  Click the URL for the [Processing Result List] screen indicated in the email message to
display the Fuji Xerox Direct [Processing Result List] screen in your web browser.

3  Check that the [Result] column corresponding to the receipt number shown in the email
message indicates "OK," and click [Download].

FUJI Xerox G: ) Fuji Xerox Direct

. » T
ContactUs  SiteMap  Home

Service List Online Purchase

Home > Service List > Operation Support Service > Software License Management > Processing Result List

License Activation/Activat Processing Result List
ion Cancellation (By File)
» After the license is activated, download the license file from the Download link and import it to the target computer.
> Uplk il : : . . "
Upload File * If there are multiple license files for 1 receipt number, unzip the downloaded zip file
# |f the result is NG or Partial NG, download the CSV file from the Details link and check the error codes and error messages
* Refer to “Error Handling” in * Information on License Activation/Activation Cancellation (By File) " for how to deal with error
codes and error messages
* Processing results for the past 30 days are displayed.

> Processing Result List

> Information on License Act
ivation/Activation Cancella

fon (By File) Display 1-9 of § items.
> Inquiry on License Activati Receipt A Uploaded On Proc Stat. Uploaded File Resu License File Download Detai
on/Activation Cancellation c
(By File) Act OM 4 ctivationinfor(Fuji
v plete vatanimonrul 0K Download Detai
ate Taro).dat

Previous n Next

Your license file is downloaded.
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Activating Using a License File

1 Log on as a user who belongs to the Administrators group.

2 From your Windows Start menu, go [All Programs] > [Fuji Xerox] > [DocuWorks] and
click [License Management Screen] to open [License Activator] (License Management

Screen).
Important If the [User Account Control] dialog box appears, click [Yes].
Note The title bar of the License Management Screen shows [License Activator].

* When your trial period is expired:
If you try to open DocuWorks Desk or DocuWorks Viewer, a dialog box appears
prompting you to activate your DocuWorks. Click [License Management Screen]
button in this dialog box.

[ Cocu'Works 3w

-,

Unable to execute as license haz not been activated.

[ Buy License. .. ] [ Activate License ]Gl__iCE:nSE ManagementScreen...D[ 0k

* When your trial period is not expired:
Launch DocuWorks Desk or DocuWorks Viewer, and go [Help] > [License
Management] and click [License Management Screen] to open [License Activator].

2] DocuWarks Desk 7 N E@
Fle Edit Wiew Document Page TIfol
? DocuWorks Help F1
® -
Fuji Xerox Web Page  »
= . =
= H e
=) |£| ‘!IE' |@| License Agreement =
License Management Buy License...

About Docuworks

{T DocuWorks Desk Activate License

= B User Folder License Management Screen..
[ Let's Start DocuWorks
[5) Ssample Doc - DocuWorks 8
& Link Folder
14 Recycle Bin
i Neighborhood
[EF Mailbox
Bl search Result
S Attribute Filter

When you display the License Management Screen for the first time, the [License Agreement] dialog
box appears.
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3 Click [Advanced Features].

License Activator

Thank you For installing Fuji ¥erox product.
‘ou can perform license related operation For Fuji Xerox product using this application,

Reqister License Delete License
Registered License Open in Another Screen
Product Mame Serial Mumber License Status
Docuworks Unactivated

Wersion Information Advanced Features Exit

4  Perform the following steps:

1) Click [Import License Activation File].
2) Click [Next].

License Activator

Advanced Features

rou can use license related advanced features using this screen,

O Licenze Activation O Licenze Deactivation
Unauthenticated registered serial will be Cancels the activation only without deleting the serial
authenticated. number.
import License Activation Fil ( ) O Delete Serial Mumber

License Activation file will be imparted. Deletes the registered serial number.

(2)

= Back. Cancel




4 Activating a License
5 Performthe following steps:

1) Click [Browse] to specify the license file downloaded from Fuji Xerox Direct.

2) Click [Next].
Your license is activated.

License Activator
Import License Activation File(1/2)

Specify the licenze file received from Fuji <erox.

Licenze File: (1 )

|| | Browse...

(2)
< Back. Cancel
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4.4

Upgrading from the Trial to the Licensed Edition

DocuWorks Trial Edition offers a 60-day trial period. When the trial period expires,
DocuWorks Trial Edition stops working. If you upgrade from the trial to the licensed edition
of DocuWorks, you will be able to continue using DocuWorks even after the expiration of the
trial period.

To upgrade from the trial to the licensed edition of DocuWorks, you must first purchase a
license. Next, activate the license by following the procedure in 4.2 "Online Activation" (P.38)
or "Activating via the License Management Screen" (P.40).

Purchasing a License Before the Expiration of the Trial Period

The following describes how to purchase a license before the expiration of the trial period.

1  Start DocuWorks Desk or DocuWorks Viewer, and from the [Help] menu, select [Buy
License] under [License Management].

The web browser starts and the Fuji Xerox Worldwide website appears.

2 Please contact your local Fuji Xerox representative, and purchase the DocuWorks
licensed product.

After you receive the DocuWorks licensed product from Fuji Xerox, perform the procedure
described in 4.2 "Online Activation" (P.38) or "Activating via the License Management
Screen" (P.40) .

Be sure to keep the license certificate, which is enclosed in the licensed product package,
in a safe place.

Purchasing a License After the Expiration of the Trial Period

When the trial period for DocuWorks Trial Edition expires, DocuWorks stops working and

displays a dialog box indicating that you cannot run the application because the license is
not yet activated.

The following describes how to purchase a license after the expiration of the trial period.

1 Click [Buy License] in the dialog box indicating that you cannot run the application
because the license is not yet activated.

The web browser starts and the Fuji Xerox Worldwide website appears.

2 Please contact your local Fuji Xerox representative, and purchase the DocuWorks

licensed product.

After you receive the DocuWorks licensed product from Fuji Xerox, perform the procedure
described in 4.2 "Online Activation" (P.38) or "Activating via the License Management
Screen" (P.40) .

Be sure to keep the license certificate, which is enclosed in the licensed product package,
in a safe place.
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4.5 Deactivating License Authentication/Transferring the
License

This section describes how to use the License Management Screen to deactivate the
DocuWorks license.

Important In case you cannot perform "license deactivation" and "removal of the serial
number" due to some reason such as damage on the PC, please contact your local
Fuji Xerox representative or the Fuji Xerox Support website described in "Support
Contact for License Activation".

Deactivating the License via the Internet

Your serial number is removed from License Activator after you have performed the
following procedure.

1 Log on as a user who belongs to the Administrators group.

2 Open [License Activator] (License Management Screen) using one of the following
steps.

* From your Windows Start menu, select [All Programs] > [Fuji Xerox] > [DocuWorks] >
[License Management Screen].

» Launch DocuWorks Desk or DocuWorks Viewer, and then select [Help] > [License
Management] > [License Management Screen].

Important If the [User Account Control] dialog box appears, click [Yes].

Note The title bar in the License Management Screen shows [License Activator].

3 click [Delete License].

License Activator

Thank you For installing Fuji ¥erox product.
ou can perform license related operation For Fuji Xerox praduct using this application.

Reqister License Delete License
Registered License Open in Another Screen
Product Mame Serial Mumber License Status
Docuworks Activated

Wersion Information Advanced Features Exit
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4

Select [DocuWorks], and click [Next].

License Activator

License Activation Cancellation{1/4)

Select the target for license activation cancellation. Y'ou can cancel license by praduct unit.

Product Mame Senal Mumber License Status
— — = =
Docuivorks Activated

= Back. Cancel

Select [Use the Internet to Cancel License Activation (Recommended)].

License Activator

License Activation Cancellation{2/4)

Select the license activation cancellation method.

[ @_Llse the Intarnet to Cancel License Activation (Recommendad} ]

Select this if your computer is connected to the Internet.

O Use File to Cancel Licensze Activation

Select this if your computer iz unable to connect to the Internet.
License Activation cancellation file output will be performed.

Erowse ...

Click [Next].

The deactivation of the license authentication starts.

Click [Finish].

59

Whenever you start DocuWorks after deactivating the license, you will see the message

"Unable to execute as license has not been activated".

If you have performed deactivation before the trail period expires, the software reverts

to the trial edition.
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Deactivating Your License with File

Exporting the License Activation Cancellation File

1
2

Log on as a user who belongs to the Administrators group.

Open [License Activator] (License Management Screen) using one of the following
steps.

* From your Windows Start menu, select [All Programs] > [Fuji Xerox] > [DocuWorks] >
[License Management Screen].

» Launch DocuWorks Desk or DocuWorks Viewer, and then select [Help] > [License
Management] > [License Management Screen].

Important If the [User Account Control] dialog box appears, click [Yes].

Note The title bar in the License Management Screen shows [License Activator].

Click [Delete License].

License Activator

Thank you For installing Fuiji ¥erox product.
‘fou can perform license related operation For Fuji erox product using this application.

Reqister License Delete License
Registered License Cpen in Another Screen
Product Mame Serial Number License Status
Docuiorks Activated

Yersion Information Advanced Features Exit
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4 Select [DocuWorks], and click [Next].

License Activator

License Activation Cancellation{1/4)

Select the target for license activation cancellation. Y'ou can cancel license by praduct unit.

Product Mame Senal Mumber License Status
— — = =
Docuivorks Activated

= Back. Cancel

5 select [Use File to Cancel License Activation].

License Activator
License Activation Cancellation (2/4)
Select the license activation cancellation method.

() Use the Internet to Concel License Activation (Recommended)

Select this if your computer is connacted to tha Intarnaet,

[ @_Llse Filz to Cancel License Activation: ]

Select this if your computer is unable to connect to the Internet.
License Activation canceBation fle output will be performed.

Erowse ...

<o Cancel

6 Click [Browse] to specify the export destination and file name for the license
deactivation file, and save it.

Note The default output destination is the desktop. The default file name is "LRT.dat".

7 Click [Next].

The license deactivation file is output to the specified destination with the specified name.

8  Click [Finish].
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Uploading the License Activation Cancellation File

1 use your web browser to visit the URL for the page to deactivate an uploaded file,

located in "Fuji Xerox Direct" at:
https://direct.fujixerox.com/ap2/license/bulk_activation/upload?proc=deactivation

A screen to log in to "Fuji Xerox Direct" appears.

2 Filin [User ID(E-mail Address)] and [Password], and click the [Login] button.

A page for you to upload a file appears.

3  Check that the [Cancel Activation] tab is displayed, and click the [Browse] button.

FujiXerox

i
FUJI Xerox ~ ) Fuji Xerox Direct e e
) Contact Us Site Map Home

Service List Online Purchase

Home = Service List > Operation Support Service > Software License Management = Upload File

License Activation/Activat Upload File

ion Cancellation (By File)
Select the Activate tab to activate your license, and the Cancel Activation tab to cancel it.

> Upload File

# Click the Browse button, select the file to upload, and send. You can also drag and drop the file

# You can upload up to 10 files at one time. If there are 11 or more files, send them in multiple batches

> Information on License Act

ivation/Activation Cancella
® \When replacing your computer, complete license activation cancellation first before activating the license. If you activate the

tion (By File)
license without canceling license activation, there may not be enough licenses
* [f an error occurs, refer to " Information on License Activatio tion Cancellation (By File) " for "Error Handling”
> Inquiry on License Activati )
onfActivation Cancellation I File
(By File)

Drag and drop your file here.

Send |

4  Selectthe exported license activation cancellation file, and click the [Open] button.

Note You can also drag and drop the license activation cancellation file directly.
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5  Check that the file name is displayed in the File field, and click the [Send] button.

FujiXerox

FUJI Xerox ‘:\ Fuji Xerox Direct T P = L O

Contact Us Site Map Home
Service List Online Purchase

Home > Service List > Operation Support Service = Software License Management > Upload File

License Activation/Activat Upload File
ion Cancellation (By File)
Select the Activate tab to activate your license, and the Cancel Activation tab to cancel it

> Upload File

# Click the Browse button, select the file to upload, and send. You can also drag and drop the file

* Information on License Act

- R * You can upload up to 10 files at one time. If there are 11 or more files, send them in multiple batches.
ivation/Activation Cancella

tion {By File) * When replacing your computer, complete license activation cancellation first before activating the license. If you activate the
license without canceling license activation, there may not be enough licenses
alf oo o s forio = lof ii.‘q Ll Ea Actiation Aokl ot fad Lo B Ellot = for ~E
* Inquiry on License Activati [
onfActivation Cancellation I File LRT(Fuji Taro) dat Delete Browse
(By File)

Drag and drop your file here.

The message "Received file processing request." appears.

6  You will receive an email sent from "Fuji Xerox Direct" notifying you of the completion
of the license deactivation processing.

7  Click the URL for the [Processing Result List] screen indicated in the email message to
display the Fuji Xerox Direct [Processing Result List] screen in your web browser.

8  Check that the [Result] column corresponding to the receipt number shown in the email
message indicates "OK."

FujiXerox

FUJI Xerox 6:\ Fuji Xerox Direct

ContactUs  SiteMap  Home
Service List Online Purchase
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Whenever you start DocuWorks after deactivating the license, you will see the message
"Unable to execute as license has not been activated".

If you have performed deactivation before the trail period expires, the software reverts
to the trial edition.
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5 Uninstalling Software

This chapter describes how to uninstall individual software for DocuWorks.

Important If you need to uninstall DocuWorks, before you uninstall it, refer to 4.5 "Deactivating
License Authentication/Transferring the License" (P.58) to "deactivate your license."

Note Uninstalling DocuWorks does not uninstall DocuWorks PDF Creator, nor License

Management component. These applications must be uninstalled separately, if you
wish to remove them.

5.1 Uninstalling DocuWorks 8

Uninstall DocuWorks does not automatically remove the Personal Settings. You must
uninstall your own Personal Settings after uninstalling DocuWorks 8.

Reference * For details, refer to Help [Customize DocuWorks] > [Customize Personal Settings]
> [Setup Personal Settings].

1  From the Windows [Start] menu, select [Control Panel], and then click [Uninstall a
program] in Control Panel.

2  Select [Fuji Xerox DocuWorks 8] from the list of program names, and then click
[Uninstall].

3 Cclick [Yes] in the dialog box confirming uninstallation.

Note If the [User Account Control] dialog box appears, click [Yes].

4 Follow the on-screen instructions to uninstall the application.

Important When the screen prompting you to restart your computer appears, restart your
computer. The screen prompting you to restart the computer appears when there is
a file that cannot be deleted during uninstallation. However, the uninstallation can
be completed if you restart the computer accordingly.

Note If Microsoft Visual C++ 2015 Redistributable is unnecessary, select it from the list of
program names and uninstall it.

5.2 Uninstalling DocuWorks PDF Creator

1  From the Windows [Start] menu, select [Control Panel], and then click [Uninstall a
program] in Control Panel.

2 Select [Fuji Xerox DocuWorks PDF Creator (version number)] from the list of program
names, and then click [Uninstall].

3 Click [Yes] in the dialog box confirming uninstallation.

Note If the [User Account Control] dialog box appears, click [Yes].
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4 Follow the on-screen instructions to uninstall the application.

Important When the screen prompting you to restart your computer appears, restart your
computer. The screen prompting you to restart the computer appears when there is
a file that cannot be deleted during uninstallation. However, the uninstallation can
be completed if you restart the computer accordingly.

5.3 Uninstalling DocuWorks Viewer Light 8

1  From the Windows [Start] menu, select [Control Panel], and then click [Uninstall a
program] in Control Panel.

2 Select [Fuji Xerox DocuWorks Viewer Light 8] from the list of program names, and then
click [Uninstall].

3 Click [Yes] in the dialog box confirming uninstallation.

Note If the [User Account Control] dialog box appears, click [Yes].

4 Follow the on-screen instructions to uninstall the application.

Important When the screen prompting you to restart your computer appears, restart your
computer. The screen prompting you to restart the computer appears when there is
a file that cannot be deleted during uninstallation. However, the uninstallation can
be completed if you restart the computer accordingly.
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